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New Concepts of Data Organization

Technical Note

Introduction

In analytical laboratories, chromatography data need to be acquired

efficiently in a short time. Clarifying ambiguous results can be time-

consuming, and may result in high administrative costs. Starting

with ChemStation revision B.02.01, data storage and data browsing

capabilities have been improved to enable fast review and reprocess-

ing of result data. In this Technical Note, we describe the efficient

use of the new data storage and retrieval functions in ChemStation

B.02.01/B.02.01 B.03.01 to boost your lab's productivity.  In revision

B.03.01 users can choose to keep their established workflows in

ChemStation. For both scenarios a typical workflow is described. 



Overview

This Technical Note describes the efficient use of data storage 

and retrieval functions in ChemStation B.02.01/B.03.01.

1. ChemStation Data Structure............................................................. 3

This chapter gives an overview of the differences between 

the data structure used in ChemStation revisions prior to 

B.02.01 and the new data structure in revision B.02.01 and 

its successors.

2. Data Aquisition......................................................................................4

This chapter explains how the new data structure influences 

the workflow for the acquisition of data for sequences and 

single runs.

3. Data Analysis......................................................................................... 6

This chapter outlines the data analysis and review options 

that are available, and explains how consideration of the 

data structure affects your choice of options.

4. Workflow with Unique Folder Creation switched off................ 13

This chapter provides information on working with Unique 

Folder Creation switched off which allows you to store data 

as in ChemStation revisions B.01.03 or earlier. This mode 

does not take full advantage of the latest data review and 

reprocessing functionality in ChemStation.
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ChemStation prior  to B.02.01

In ChemStation revisions prior

to B.02.01, sequences, method

and the generated data files and

results were stored in fixed spec-

ified and separated paths. For

example, methods were refer-

enced by name in a sequence and

it was the user's responsibility to

maintain the integrity of 

methods, sequences, and data

files. Because of this, the long-

term archiving of data, and

reproduction of results was a

tedious task. Users had to docu-

ment the chromatogram, results,

and associated method; this was

the case not only for regulated

labs, but also for some areas of

unregulated labs (such as envi-

ronmental labs). In ChemStation

prior to B.02.01, this could be

achieved only by printing every-

thing on a report.

ChemStation B.02.01/B.03.01 

In order to strengthen the associ-

ation between data files and

methods, the following new data

organization scheme has been

implemented with ChemStation

B.02.01/ B.02.01 SR1. When used

with the ChemStation, the Agi-

lent Enterprise Content Manager

(ECM) also makes use of the new

data concept, since the complete

data set (sequence/methods/data

files) can  now be transferred

(archived) to ECM as one entity

(figure 1).

The methods in the folder

Chem32\1\methods serve as

master methods, i.e. during

acquisition and data analysis,

they remain unchanged once

method development has  been

completed.

Similarly, the sequences in the

folder Chem32\1\sequence serve

as sequence templates that can

unchanged for future sequence

execution.

While executing the sequence, all

generated data files (*.d) are

stored in the sequence data fold-

er, along with the corresponding

batch file (*.b) and sequence log

file (*.log).

3. Each data file contains two 

copies of the method used to 

create the run.

• The first one, called ACQ.M, is 

saved directly after the 

acquisition part of the method 

is completed.

• The second copy, called DA.M, 

is saved after completion of 

the data analysis part. 

The preservation of the state of

the method at acquisition of the

specific data file is thus ensured.

The DA.M can be modified during

data analysis. In this case, these

two methods may differ if, for

example,  the calibration table is

updated.

Figure 1

Sequence acquisition.

be used to rerun (but not

reprocess) a sequence several

times.

The data storage pattern varies

depending on whether single run

data or sequence data is

acquired:

1. When a sequence is executed,

a new folder is automatically cre-

ated (“sequence container”) with

a unique name in the specified

subdirectory. When a single sam-

ple is run, the data file  (*.d) is

written to the specified subdirec-

tory.

2. For sequence data, the execut-

ed sequence template (*.s) and

all the methods  (*.m) involved

are copied into the sequence con-

tainer. The copies of the methods

are called the "sequence meth-

ods" in order to distinguish them

from the original master meth-

ods. All sequence-related tasks

(e.g. acquisition and data analy-

sis) are performed on the copies

of the sequence and the methods.

Therefore, the sequence template

and the master methods remain

1. ChemStation Data Structure
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Figure 2

Preferences dialog / Paths tab.

The following sections explain

the impact of this structure on

typical workflows in more detail.

Starting with ChemStation

B.02.01, flexible data storage for

single runs and sequences allows

you to specify various saving

locations without reconfigura-

tion. The Path Tab in the newly

introduced Preferences dialog

box in the View menu gives you

the opportunity to add multiple

paths in addition to the default

path C:\chem32\x\DATA (where

x is the instrument number).

Using the Add and Remove but-

tons, existing paths can be sim-

ply deleted, or you can navigate

to a selected location and add

the path to the new location into

the Preferences.  The default

path cannot be removed from the

list, but can be changed in the

Configuration Editor (figure 2).

All newly specified Data Paths

are then available for selection in

the Sample Info/ Sequence Para-

meters dialog box when perform-

ing runs (figure 3).

Data Acquisition in a Sequence 

In order to run a sequence,

appropriate pre-defined methods

must be available. These are the

master methods as outlined

above. Typically, master methods

and sequence templates are

worked on in the Method and

Run Control view of the Chem-

Station. For this reason, in

Method and Run Control view,

the ChemStation Explorer pro-

vides access to master methods

and sequence templates.

The sequence template refer-

ences these methods in the

Figure 3

Data path selection.

2. Data Acquisition
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sequence table.

As explained previously, when a

sequence is run with sequence

template <sequence_name>.S and

the master method <method

_name>.M is used, a new folder

is created containing all resulting

files from the sequence run

(“sequence container“). The loca-

tion of this folder is determined

by the settings in the Sequence

Parameters dialog box and the

naming is determined by the

Sequence tab of the Preferences

dialog box. By default, the name

is <sequence _name> <acquisi-

tion _date> <acquisition_time>,

but it can be configured by using

the tokens Operator, Instrument,

Counter, and PC Name, or you

can manually enter any name

(figure 4).

At the start of an acquisition

sequence, the method specified

in the sequence table is copied

from the master methods folder

into the sequence container. In

addition, a copy of the sequence

is created and placed with the

sequence log and the batch (*.b)

file in the sequence container. All

updates of the method (e.g.

updates of the calibration table)

are written to this sequence

method in the container. All nec-

essary files are now available for

future data review and repro-

cessing, without changes that

were applied to the master

method or sequence template for

other sequence runs.

During acquisition, the data files

are stored to the sequence con-

tainer. Within each data file

(*.D), two additional methods,

ACQ.M and DA.M, are saved for

this specific run. These two

methods are copies of the

sequence method, preserving the

state of the method as it was at

the time of acquisition of the spe-

cific data file. In the case of e.g.

calibration table updates the

DA.M methods differ for each of

the runs.

The individual acquisition

method ACQ.M is intended to

preserve the acquisition parame-

ters, therefore it is recommended

that you do not change this

method during future data

review activities. 

With these files saved in the

sequence folder, all data review

and reprocess activities can be

performed without altering the

master method or the sequence

template. If needed, method

changes can also be saved to the

master method again.

Data Acquisition of Single Runs

The new data concept is also

introduced for single runs start-

ing with ChemStation B.02.01

SR1.  In this case the data file is

saved directly into the respective

subdirectory. Since only one

method is employed for a single

run, this method does not need

to be copied into the subdirecto-

Figure 4

Preferences dialog / Sequence tab.
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ry. 

All actions are performed direct-

ly with the master method. After

the acquisition part of the

method is completed a copy of

the master method is saved into

the data file directory (ACQ.M).

Another copy (DA.M) is saved

after the data analysis part of the

master method has been execut-

ed.

Once the data have been

acquired, they can be analyzed in

ChemStation Data Analysis view.

When selecting the Data tab of

the ChemStation Explorer, you

can load all the runs of a

sequence or all single runs in a

specific folder by double-clicking

the corresponding symbol. The

corresponding data set is then

available in the Navigation Table

(figure 5). 

The main body of the Navigation

Table consists of a list of all runs

of the set. Instead of loading a

run via the File / Load Signal

menu, a run can now be loaded

into ChemStation memory by

double-clicking the relevant line

in the Navigation Table. Once the

run is loaded, you can review it,

i.e. adjust data analysis parame-

ters, integrate the signals and

finally print a report. In this case

you analyze the run as a single

run without taking the sequence

context into account. This way of

data analysis is called “Data

Review”. The Navigation Table

provides the tool set shown in

figure 6, which makes data

review more convenient.With this

toolset, you can jump to the

beginning or end of the Naviga-

tion Table, step on to next or pre-

vious run, automatically step

through the runs, and stop auto-

matic stepping.

A different way to analyze your

data is to “Reprocess” a complete

sequence. During this process, all

runs are reanalyzed in the

Figure 5

Loading a sequence from the ChemStation Explorer into Navigation Table.

Figure 6

Data review toolset of the navigation table.

Figure 7

Sequence Reprocessing toolset of the 

Navigation Table.

Figure 8

ChemStation B.02.01 Method and Run Control Sequence Parameters

3. Data Analysis
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sequence context, i.e. the calibra-

tion tables of the sequence meth-

ods are updated in the case of

calibration runs, multipliers,

amounts etc. can be changed in

the sequence table, new methods

can be added to the sequence

container, etc. For reprocessing,

the Navigation Table provides the

toolset in figure 7.

Please note, the reprocessing

icons in the Navigation Table are

available only for sequence data

generate starting with ChemSta-

tion B.02.01 and higher. For Sin-

gle Run data, as well for data

generated prior to B.02.01 repro-

cessing in Data Analysis is not

accessible. Sequence aquired

prior to B.02.01 need to be

reprocessed in “Method and Run

Control”, defining the sequence

parameter “parts of method to

run” to “reprocess only”. For

B.02.01 and higher generated

sequence, the reprocessing

option in Method and Run Con-

trol has been removed, and the

Navigation Table offers repro-

cessing as an Data Analysis Task. 

(figure 8).

Data Analysis Data Review

Data Review means analyzing on

a run-per-run base. ChemStation

allows you to specify default

actions that are performed auto-

matically when a data file is

loaded from the Navigation

Table. These include data analy-

sis tasks like integrating the

chromatogram directly after

loading, and also to specify the

method that is to be loaded. The

corresponding options for

reviewing (not used for repro-

cessing) are set up on the

“Review/Signal Options” tab of

the Preferences dialog (figure 9).

The first section, “Load Signal

Options”, specifies which of the

signals in a run are loaded, and

if the chromatograms are to be

integrated and the results report-

ed directly after loading. In the

second section,”Data Review

Options”, you have the possibility

to configure the interval for step-

ping through the runs in the Nav-

igation Table automatically. The

remainder of this section speci-

fies which method is loaded dur-

ing data review when a run is

loaded from the Navigation

Table. 

Table 1 shows the separate

Table 1

Data Review options for Sequence and Single Run data.

Method used for review of sequence data Method used for review of single run data

Current method Current

Sequence method Individual method from data file (DA.M)

Individual method from data file (DA.M)

option sets that are available for

sequence runs and single runs.

The following sections describe

how to use these options in dif-

ferent workflows.

Keep “Current Method”

The review setting “Current

Method” should always be used

when you want to use the

method that is currently loaded.

In this respect, for data review

the current method remains irre-

spective of which single run data

file or sequence container file is

loaded. This setting should be

used for method development, to

Figure 9

Preferences dialog / Signal/Review Options tab.



8

create a calibration table or

other updates. For example, you

run a sequence with runs of dif-

ferent concentrations in order to

optimize integration parameters,

and afterwards build the calibra-

tion table. As these changes in

data analysis parameters must be

available for all future acquisi-

tion runs, you have to apply

them to the master method. In

order to do this, you select the

option “Current Method” in the

Preferences dialog, (figure 10).

This ensures that, for each run

loaded, the same method is

always kept in memory.

You load the master method,

most conveniently from the

Method tab of the ChemStation

Explorer.

Now, you optimize the integra-

tion parameters and use the runs

to construct the calibration table.

All future acquisitions using this

method will apply these opti-

mized data analysis parameters.

Load “Sequence Method”

It may also occur that sequence-

specific events require changes

in all the methods employed with

the sequence. Once every run has

been reviewed and the sequence

methods have been improved, the

complete sequence can be

reprocessed with the updated

methods. In this scenario, you

review the data using the option

“Sequence Method” (figure 11).

This means that each time you

load a run from the Navigation

Table, the sequence method cor-

responding to the run's sequence

line is loaded. Once the data

review has been completed, it

may be necessary to reprocess

Figure 10

Keep the current method for data review.

Figure 11

Load Sequence Method for data review.

Figure 12

Load Individual Method from Data File for data review.
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the complete sequence in order

to apply the method changes not

only on a run-per-run base, but

also in the complete sequence

context (including calibration

table updates etc.).

Load “Individual method from

data file”

The review setting “Individual

Method from Data File (DA.M)”

(figure 12) should be used, if you

want to load  the individual

DA.M automatically along with

the corresponding datafile, when

this file is loaded using the navi-

gation table. When you change a

method and then load the next

run, you will be asked to save

your method changes, because

you load a new method: the

DA.M of the next run.

Various workflows may require

that you always review data with

the individual data analysis

method (DA.M) loaded. For

example, when all runs are

loaded with DA.M, the analysis

results are the same as during

acquisition or last reprocessing.

Additionally, it is possible to per-

form run-specific changes and

save them in the individual data

analysis method of the run. This

is especially useful for manual

integration events.

Using the individual data analy-

sis method (DA.M) a convenient

means is available to store manu-

al integration events to a specific

data file only. So, when you use

the automatic review and print

the reports, the specific manual

integratios are reported in one

shot. Use the following steps to

copy manual integration events

to a method (figure 13).

1. Perform manual integration

until the results are satisfactory.

2. Select Integration -> Copy

Manual Events to Method. When

the manual events have been

saved to the individual method

(instead of e.g. the corresponding

master method), it is probably

most useful to always apply

those events when the chro-

matogram is integrated.

Figure 13

Copy Manual Integration Events to a Method.

Figure 14

Apply the Manual Integration Events each time

the chromatogram is integrated.

Figure 15

User Interface in Data Analysis.

3. Check the “Manual Events”

option in the Integration Events

dialog (figure 14).

4. Save the method.

Note: When a sequence is

reprocessed, all actions are per-

formed on the sequence methods

and the DA.M of each data file is

overwritten, including the man-

ual integration events!

ChemStation user interface during 

data review

(1) (2

(3)
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The ChemStation user interface

provides a number of features to

facilitate working with the differ-

ent methods available for data

analysis (figure 15).

1. The method modification sta-

tus is displayed in Data Analysis

view, so you can easily follow if

there are unsaved method

changes. The user interface

always displays the name of the

currently loaded method (togeth-

er with the information whether

it is an individual data analysis

method of a data file or a

sequence method). 

2. When you move the mouse

pointer over this field, a tool tip

additionally displays the com-

plete path and name of the

method.

3. A dropdown box provides a

“shortcut” to the method options

of the Preferences dialog. You

can directly enable any of the

available options and it will be

applied the next time you load a

run from the Navigation Table.

Moreover, it is also very conve-

nient to see which option is cur-

rently active.

Update master method feature 

During working on the individual

data analysis method, you may

decide that you want to have the

data analysis parameters you

developed for the individual

method available for the

sequence or master method. A

right-click in the Navigation

Table on the corresponding run

allows you to update your

sequence or master method with

the data analysis parameters.

(figure 16)

This feature is available in the

situations listed in table 2. It is

important to note that this fea-

ture only updates data analysis

parameters of the target method,

and that it overwrites all data

analysis parameters.

Note: For technical reasons, in

addition to the data analysis

parameters, the Method Change

Figure 16

Update Master or Sequence Method.

Table 2

Availability of the Update … Method functionality.

Loaded method Available options

Individual data analysis method (DA.M) Update Master Method

Update Sequence Method

Sequence Method Update Master Method

Master Method –

Figure 17

Toolset for Sequence Reprocessing.
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Figure 19

Sequence Table in Data Analysis.

Figure 18

Browse to the Master Methods Directory in the Sequence Table.

History of the target method is

also overwritten with History of

the source method. 

Data Analysis: Reprocess your Data

In contrast to data review,

sequence reprocessing means

that all the runs of a sequence

are reanalyzed in the sequence

context, i.e. including calibration

table updates, parameters

changes in the sequence table,

additions of new methods to the

sequence, etc.With the new data

organization concept, the

sequence container includes all

files needed for reprocessing: the

data files, a copy of the sequence

file, and all the sequence meth-

ods originally employed with the

acquisition. Thus, in order to

reprocess a sequence you simply

have to load it into the Naviga-

tion Table and the required tool

set is available (figure 17).

Please note the following rules

with regard to reprocessing:

• All actions are performed on

the sequence methods. If

changed data analysis parame-

ters are to be applied, you have

to change the sequence methods.

• The method loading settings of

the Preferences dialog have no

influence on reprocessing; it

always works on the sequence

methods. This feature set is valid

for reviewing only.

• During reprocessing, the Batch

(*.b) file, the sequence/single run

log (*.log), the Navigation Table,

and the individual data analysis
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method (DA.M) of each processed

data file are updated.

• If you want to add new meth-

ods from one of the master

method directories to the

sequence table, you have to use

the Browse item in the list of

methods to browse to any speci-

fied method directory. The new

method is also copied to the

sequence container during repro-

cessing. This implies that you

cannot select a method with the

same name as a method already

present in the container (figure

18).

5) In the sequence table, it is not

possible to add or remove lines. 

6) In the Sequence Parameters

dialog, only a limited set of fields

can be changed, e.g. Dilution,

Sample Amount. All other fields

have been set during data aquisi-

tion (figure 19).

How to configure back to earlier Chem-

Station UI

If you prefer the ChemStation UI

of previous revisions, perform

the following steps:

1) Collapse the ChemStation

Explorer with its tree view and

navigation buttons by clicking

the push pin at its upper right

corner; the side bar collapses

and frees more screen estate for

the customary ChemStation user

interface. Now, when you move

the mouse over the side tab, it

Figure 20

Collapse and expand the ChemStation Explorer.

Figure 21

Hide the Navigation Table.

Figure 22

Keep Current Method for data review.
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This section provides informa-

tion on working with Unique

Folder Creation switched off

which allows you to store data as

in ChemStation revisions B.01.03

or earlier. This mode does not

take full advantage of the latest

data review and reprocessing

functionality in ChemStation.

Working with Unique Folder Creation
on or off?

The new data concept as outlined

in the previous chapters provides

a number of advantages:

• Sequence data are not over-

written. Each sequence acqui-

sition stores the resulting data

files in its own sequence con-

tainer with unique name.

• With the sequence container

concept, the data are stored

with all necessary information

needed for data analysis, i.e.

copies of the sequence file and

of all methods employed with

the sequence. These methods

can be changed with sequence

specific input and do not influ-

ence the original master

method. The container concept

thus strengthens the meaning

of a sequence as a set of data

files and methods belonging

together for result creation.

• Data review and reprocessing

are both available in Data

Analysis view via the Naviga-

tion Table.

• The data container concept

provides the optimal precondi-

tions for the ChemStation Inte-

gration with the Agilent Enter-

prise Content Manager (ECM).

However, there may be situa-

tions where users may want to

store their data as in Chem-

Station B.01.03 or earlier and

work according to the corre-

sponding workflows:

• During method development it

may be more convenient to

have only one method for both

acquisition and data analysis

to automatically have changes

available for future acquisition

and reanalysis of already

acquired data.

• Data from several acquisitions

have to be in one folder, e.g. in

case of partial acquisition.

• Customized macro solutions

on a ChemStation system that

have been designed for older

revisions may require the data,

methods, or sequence to be

stored according to the old

data organization scheme.

• When ChemStation B.03.01

runs in a lab where there are

also system still running on

ChemStation revisions B.01.03

or earlier, it may be more con-

venient to use the same data

organization mode on all sys-

tems.

Working with Unique Folder Creation
switched off

In order to allow working with a

data storage concept as in Chem-

Station revisions before B.02.01,

the Sequence tab of the Prefer-

ences dialog box a Data Storage

section. Here you can choose

between Unique Folder Creation

ON and Unique Folder Creation

OFF (figure 23). Per default,

Unique Folder Creation ON is

selected. Unique Folder Creation

ON enables the data storage con-

cept as outlined before.

Note: 

Switching Unique Folder Cre-

ation on or off only affects

Figure 23

Preferences Dialog/Sequence Tab

4. Workflow with Unique Folder Creation switched off
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future acquisitions, but does not

change the data organization of

already acquired data. We rec-

ommend to decide between the

two modes at the beginning of

your work and not to switch

between them. Switching Unique

Folder Creation off is not sup-

ported with the ChemStation

ECM Integration or

ChemStore/Security Pack

installed.

Selecting Unique Folder Cre-

ation OFF has the following

impact on data storage:

• Sequence data are not

acquired into a sequence con-

tainer, but directly into the

subdirectory as specified in

the Sequence Parameters.

Therefore, the sequence name

pattern is grayed out on the

Sequence tab of the Prefer-

ences dialog (figure 23).

• This means that for two or

more sequence acquisitions

the data may be acquired into

the same subdirectory. This

implies the risk to overwrite

existing data, but on the other

hand allows to split sequences

using partial sequence execu-

tion and still combine the

results in one folder (which

would not be possible with

Unique Folder Creation

switched on).

• No sequence methods (.M) or

copies of the sequence file (.S)

are stored with the data, but

only the sequence logfile and

the batch file (.B). This means

only the methods and se-

quences in the paths specified

in the Preferences dialog are

available. They have to be used

for acquisition as well as for

data review and reprocessing.

Sequence or data file specific

method changes can only be

stored by saving the method

with different name. Other-

wise these changes are also

applied to the acquisition

method. On the other hand,

this may be desired behavior

during method development.

There are no data file specific

methods ACQ.M and DA.M

stored. Saving information about

the original acquisition is only

possible by including this infor-

mation in the report or by select-

ing Save Method with Data from

the method’s runtime checklist

(figure 24). 

With this option the acquisition

method will be stored as RUN.M

in each data file.

The enhanced ChemStation user

interface as introduced with

ChemStation B.02.01 is also

available when Unique Folder

Creation is switched off.

However, there are functions you

can not take advantage of in this

mode. The same limitations also

apply to any run acquired with

ChemStation prior to B.02.01.

• When a sequence is loaded into

the Navigation Table, the

reprocessing toolset is grayed

out (figure 25). Sequences that

have been acquired in this

data storage mode can only be

reprocessed in Method and 

Run Control view using the

Reprocessing only option in 

the Sequence Parameters 

Figure 24

Runtime Checklist: Save Method with Data.
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stored with the data. In this

case, the only meaningful

option for data review is Use

current method.

Conclusion

With revision B.02.01/B.02.01

(figure 26).

• With the method usage options

Use method from data file and

Use sequence method, a warn-

ing message will be displayed

each time a run is double-

clicked in the Navigation

Table that the individual

method/ sequence method

does not exist. As outlined

above, these methods are not

SR1 of ChemStation, data review

and data reprocessing capabili-

ties have been significantly

improved to enable fast review of

result data.

The new data storage functions

in ChemStation help to efficient-

ly organize sequence data and 

methods. This provides also easi-

er connectivity with the Agilent

Figure 25

Naviagation Table for Seqeunces aquired with Unique Folder Creation switched off

Figure 26

Reprocessing of sequence data acquired with Unique Folder Creation switched off.



expands temporarily to allow you

to use it until the mouse leaves

that region (figure 20). Of course,

when you click the push pin

again,  the side bar reverts to its

fixed state.

2) In Data Analysis View, hide

the Navigation Table by pressing

the Hide/Show-button on the

toolbar indicated in figure 21.

3) Change the method loading

settings to “Current Method” in

the Preferences. This allows you

to work always only on the mas-

ter methods or on any manually

selected method as in previous

ChemStation revisions (figure

22).

Please note, that with these

changes the ChemStation will

look more familiar, but many of

the new features and their bene-

fits are no longer available.
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